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1 Safety

1.1 Designated use

ControlCare is a field-based control system comprising hardware and software components. It can 

be used to visualize, monitor and control production processes. The approved usage of the 

individual units used in the system can be taken from the corresponding parts of the operating 

instructions.

The software described in this particular manual allows the programming of the hybrid function 

block in IEC 61131-3 language as well as the engineering, configuring and commissioning of a 

ControlCare SFC162 FOUNDATION Fieldbus. The same procedures can be used for the SFC173 

PROFIBUS Field Controller. Structured Text has been taken as an examples, and the building of 

appropriate control strategies using it and the function blocks contained in the Field Controller and 

connected devices are described.

1.2 Installation, commissioning and operation 

ControlCare Field Controllers have been designed to operate safely in accordance with current 

technical safety and EU directives. Essential to their use is the ControlCare Application Designer 

software suite, which allows control strategies to be created for FOUNDATION Fieldbus and 

PROFIBUS I/O applications. Field devices, links, junction boxes, cables and other hardware 

comprising the Fieldbus sytem must also be designed to operate safely in accordance with current 

technical safety and EU directives. 

If devices are installed incorrectly or used for applications for which they are not intended, or if the 

controller is not configured correctly, it is possible that dangers may arise. For this reason, the system 

must be installed, connected, configured, operated and maintained according to the instructions in 

this and the associated manuals: personnel must be authorised and suitably qualified.

1.3 Operational safety

Location Field Controllers must be mounted in a permanent and weather-protected location in a safe area. 

The environment shall be a metal cabinet or an installation frame with a well grounded mounting 

plane. The environment shall be protected. 

Hazardous areas The controller must be connected to networks operating in explosion hazardous areas via barriers 

or other safety components. When installing components in explosion hazardous areas:

•  Ensure that all installion and maintenance personnel are suitably qualified

•  Check that all equipment has the appropriate safety certificates

•  Observe the specifications in the device certificates as well as national and local regulations.

This topic is discussed in BA013S (FF Guidelines) and BA034S (PROFIBUS Guidelines).

EMC All modules are suitable for industrial use and conform with the following standard, see Appendix:

•  EN 61326: 1997/A1: 1998

Interference emmision: Class A apparatus

Interference immunity: as per Annex A, industrial environment

Depending upon the environment in which the bus is operating, particular attention should be paid 

to the grounding of the bus cables. This topic is discussed in BA013S (FF Guidelines) and BA034S 

(PROFIBUS Guidelines).
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IP Address A ControlCare Field Controller is normally configured from a workstation connected into the 

control system backbone. You will require a unique IP address to set it up.

Warning

• The use of IP addresses is strictly controlled. Usually your system administrator will be authorised 

to allocate unique addresses. Assigning an unauthorised address to a Field Controller may result 

in conflicts within your system and the failure of the associated devices!

It is recommended that ControlCare Field Controllers and OPC servers are not installed in an office 

network, as the large data packets exchanged between office equipment may lead to timeouts and 

intermittent communication errors. Ideally, the ControlCare system network should operate within 

its own IP domain; if this is not possible it should be separated from other parts of the network by 

a managed switch.

Since the system can be accessed and manipulated through the various ControlCare tools, it is 

advisable to control access both to the workstation and the folders in which the configuration is 

stored. Always make a back-up of the project.

Technical improvement Endress+Hauser reserves the right to make technical improvements to its software and equipment 

at any time and without prior notification. Where such improvements have no effect on the 

operation of the equipment, they are not documentated. If the improvements effect operation, a 

new version of the operating instructions is normally issued. 

1.4 Conventions and icons

In order to highlight safety relevant or alternative operating procedures in the manual, the following 

conventions have been used, each indicated by a corresponding icon in the margin. 

Safety conventions Icon Meaning

A note highlights actions or procedures which, if not performed correctly, may indirectly affect operation or 

may lead to an instrument response which is not planned

Caution!

Caution highlights actions or procedures which, if not performed correctly, may lead to personal injury or 

incorrect functioning of the instrument

Warning!

A warning highlights actions or procedures which, if not performed correctly, will lead to personal injury, a 

safety hazard or destruction of the instrument
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1.5 ControlCare documents

Table 1.1 indicates the documents, planned and realized, containing safety relevant information, 

installation, commissioning and operating instructions for the equipment and software associated 

with ControlCare.

All documentation available at the time of release is included on the ControlCare CD-ROM and is 

installed in Start=>Programs=>Endress+Hauser=ControlCare=Manuals during set-up.

Tab. 1-1: ControlCare Documentation

Component Description Document type Designation Order No.

System ControlCare System Overview Operating manual BA016S/04/en 56004883

ControlCare System Design Operating manual BA039S/04/en Planned

ControlCare System Specifications Operating manual BA040S/04/en 56004888

Software Application Designer Overview Operating manual BA017S/04/en 70104301

Application Designer: Local I/O Tutorial Operating manual BA032S/04/en 71095009

Application Designer: FF Tutorial Operating manual BA019S/04/en 70101151

Application Designer: PROFIBUS Tutorial Operating manual BA036S/04/en 70101152

Application Designer: MODBUS Tutorial Operating manual BA037S/04/en 70101153

Application Designer: IEC 61131-3 

Ladder Logic Tutorial 

Operating manual BA038S/04/en 70101386

Application Designer: IEC 61131-3

Structured Text Tutorial

Operating manual BA056S/04/en 71060063

Field Control (OPC) Servers Operating manual BA018S/04/en 71031428

SFC162 Visitor Operation manual BA069S/04/en 71113457

Field Controller Hardware Installation Guide Operating manual BA021S/04/en 56004885

Commissioning and Configuration Operating manual BA035S/04/en 56004887

Function Blocks Function Block Manual Operating manual BA022S/04/en 56004886

Set-Up Getting Started Operating manual BA020S/04/en 56004884

General FOUNDATION Fieldbus Guidelines Operating manual BA013S/04/en 70100707

PROFIBUS Guidelines Operating manual BA034S/04/en 56004242
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2 Task Description

This tutorial describes the steps necessary for setting up the project described below. It does not aim 

to give an exhaustive account of Application Designer functions, but rather shows you one of a 

number of methods to reach your goal. The tags and names used in the tutorial are imaginary and 

will be different in a proper application. A full description of Application Designer functions is to be 

found in Application Designer Overview BA017S/04/en. Function block descriptions are to be 

found in BA022/04/en, Function Block manual.

2.1 Valve control for tank level

For this tutorial, the case of valve control for a tank level will be used, see Fig. 2-1. 

Fig. 2-1:  Overview of valve control for tank filling

A buffer tank provides a head of liquid for a downstream process. It is filled by recirculated and fresh 

liquid streams. The fresh liquid is added only when the level falls below 30%. The level of liquid in 

the tank is monitored by a level transmitter and controlled by a valve: ideally the level should be 

60% of total capacity. The values monitored are the level and mass of liquid in the tank, the total 

flowrate of liquid and the number of times the pumps are switched on.

If the level of liquid exceeds 80%, the pumps are switched off. Similarly, if the level drops below 

30%, the valve is closed and Pump 1 switched on. The hysteresis in both cases is 10%. In the event 

of the failure of the level transmitter, protection is provided against tank overspill and dry running 

of downstream pumps by two limit switches. An emergency stop is also possible.

The signals are acquired as follows:

•  Temperature, level and valve position by appropriate FF devices

•  Overspill protection, dry run protection and emergency stop to DI-0 to DI-2 inputs of a Field 

Controller SFC432 Mixed Discrete I/O module: 0 V = False, 24 V = True

•  Pump output current from DO-0 and DO-1 outputs of the Field Controller SFC432 Mixed 

Discrete I/O module: NO relay, False = Pump ON, True = Pump OFF, Fail Safe = Pump OFF
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For the tutorial all control is done in a FOUNDATION Fieldbus SFC162 Field Controller. The 

temperature and level devices provide only the measured values, the valve positioner responds to 

the output of the PID block. For this reason, the project can be replicated in the PROFIBUS SFC173 

Field Controller, with PROFIBUS devices providing the measured values. The only differences lies 

in the creation of the FOUNDATION Fieldbus and Profibus networks, see the approriate tutorials.

2.1.1 Control strategy

Fig. 2-2 shows a schematic diagram of the level control application. The analog level input is fed to 

the first Analog Alarm block which generates a true signal when the 30% LO limit is reached, the 

second Analog Alarm block generates a true signal when the 80% HI level is reached. The resulting 

discrete input signals are used to switch the pumps on and off as required. This is a standard function 

block, and eliminates the need to provide a similar signal conditioning program within the hybrid 

block. 

The level and temperature signals are fed into the hybrid block which is used to calculate the various 

functions. Two constant blocks are used to simulate the liquid flow rates. The calculations of mass, 

flow and counter incrementation are all made within the hybrid block, which then outputs the 

results. The level signal is simply fed through the hybrid block to the to the PID block. 

The Overspill, Dry Run and Emegency signals are collected in a Multiple Discrete Input block and 

the pump output control signal is fed to a Multiple Discrete Output block. The valve is closed on 

dry run or emergency be using the tracking parameter of the PID block. The control algorithm is 

programmed in the hybrid block. 

Fig. 2-2:  Schematic diagram of level control application
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2.1.2 Control algorithm

The truth table for the hybrid function block has is as follows:

Overspill and 80% tank level must lead to the pumps being switched off. On emergency, the valve 

must be closed in addition. For Dry Run and 30% tank level the valve must be closed.

The calculations to be performed in the hybrid block are as follows:

•  Mass of liquid = Volume x Density

for a horizontal cylinder of diameter 2 m and height of 3 m (0% to 100%)

Volume = r2l = (22/7) x 12 x 3 x (%Level/100)

whereby the density of the liquid (kg/m3) is dependent upon temperature

•  Total flow = Flow_1 + Flow_2

•  No. pump starts

No. of times pump switched on = No. of times OUT_D1 and OUT_D2 change from TRUE to 

FALSE

2.1.3 Aliasing

For this tutorial the signals to and from the multiple hybrid block will be aliased as follows:

The aliasing may be performed when characterizing the blocks, as described in the ladder Logic 

tutorial, BA038S/04/en, or in the creation of the strategy. Since for FOUNDATION Fieldbus it is 

normal to create the strategy before characterizing the blocks, the aliasing for links between blocks 

will be performed here. Contained parameters that are to be monitored by the supervisory system, 

however, must still be set up during characterization of the hybrid block.

Function IN_D1 IN_D2 IN_D3 IN_D4 IN_D5 OUT_D1 OUT_D2 OUT_D3

Overspill True – – – – True True –

Dry Run – True – – – – – True

Emergency – – True – – True True True

Tank 30% – – – True – – – True

Tank 80% – – – – True True True –

0°C 4°C 10°C 20°C 30°C 40°C 50°C 60°C 70°C 80°C 90°C 100°C

999.9 1000 999.7 998.2 995.7 992.2 988.1 983.2 977.8 971.8 965.3 958.4

Block Signal Block Signal Alias

AALM_2 OUT HY_EMB_IO IN_1 Product_Level

CCHAR OUT IN_2 Product_Density

CT_2 OUT IN_3 Flow_1

CT_1 OUT IN_4 Flow_2

MDI OUT_D1 IN_D1 Tank_Overspill

OUT_D2 IN_D2 Pump_Dry_Run

OUT_D3 IN_D3 Emergency_Stop

AALM_1 OUT_ALM IN_D4 LO_Level

AALM_2 OUT_ALM IN_D5 HI_Level

Output from HSE server IN_D6 Operator_Entry_Emergency

– Pump_Start_Counter_Reset

HY_EMB_IO OUT_1 PID IN Level_Output

OUT_2 Output to IEC server Product_Mass

OUT_3 Total_Flow

OPC retained Number_Pump_Starts

OUT_D1 MDO IN_D1 Pump_1_Control

OUT_D2 IN_D2 Pump_2_Control

OUT_D3 PID TRACK_IN_D Close_Valve
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2.1.4 Network

The project uses a FOUNDATION Fieldbus SFC162 with local I/O. The control strategy has been 

designed such that it can be transferred to a PROFIBUS SFC173 Field Controller, i.e. no control is 

done in the field. The network is assumed to be constructed as shown in Fig. 2-4. 

•  Temperature and level signals are supplied by FOUNDATION Fieldbus devices

•  Flow signals would normally be supplied by FOUNDATION Fieldbus flowmeters, in our 

example however, they will be simulated by using Constant Blocks in the Field Controller

•  The level overspill, dry rin and pump signals are acquired by a SFC432 Discrete Input/Output 

module

•  The pump power supplies are connected to a SFC432 Discrete Input/Output module.

Fig. 2-3  Network for application example
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2.2 Preliminaries

2.2.1 Installation and commissioning

Before you can start the IEC 61131-3 Structured Text tutorial, the Application Designer Suite must 

be installed on your computer, the SFC162 FOUNDATION Fieldbus Controller installed and 

commissioned and a connection made to your computer. Instructions on how to do this are to be 

found in:

•  Operating Instructions BA020S/04/en, Getting Started

•  Operating Instructions BA021S/04/en, Field Controller: Hardware Installion

•  Operating Instructions BA035S/04/en, Field Controller: Commissioning and Configuration

Not all project steps are described in detail, so it is recommended that you also have the 

FOUNDATION Fieldbus or PROFIBUS tutorials at hand:

•  Operating Instructions BA019S/04/en, Application Designer: FOUNDATION Fieldbus tutorial

•  Operating Instructions BA036S/04/en, Application Designer: PROFIBUS tutorial

2.2.2 Rack assembly

The SFC162 Field Controller and SFC432 Discrete I/O module have combined power demand of 

132 mA @ 24 VDC and 760 mA@ 5 VDC. Even allowing for a tolerance of 20%, this is easily 

covered by a SFC050 or SFC056 rack power module (300 mA @ 24 VDC and 3000 mA @ 5 VDC). 

The SFC353 module is powered by the SFC252 fieldbus power supply and need not be considered 

in the calculation. See Chapter 10 of BA040S/04/en, ControlCare, System Specifications.

The Field Controller and local I/O are mounted on two SFC901A rack assemblies with addresses 

0 and 1 (I/O cannot be mounted on a rack with the address "0".) The parameters for commissioning 

the Field Controller are shown in Table 2-1.

Tab. 2-1: Parameter settings for rack in hardware configuration and function blocks

Note!

• The channels used to connect to the modules to the function blocks are given by the 

Rack (R), Slot (S), Group (G) and I/O point (P) indices = RRGSP, whereby counting starts at "0". 

• Since Multiple Discrete Input and Output blocks are being used for the discrete signals, the I/O 

point index is "9", see BA035S/04/en, Field Controller, Commissioning and Configuration.

2.2.3 External devices

ControlCare local I/O modules are available with passive electrical circuits only, so that any 

connected devices or external circuits must have their own power supply, see BA035S/04/en, 

Field Controller, Commissioning and Configuration.

Rack 0 Rack 1

Slot 0 Slot 1 Slot 2 Slot 3 Slot 0 Slot 1 Slot 2 Slot 3

Module SFC050 SFC162 SFC252 SFC353 SFC432 Dummy Dummy Dummy

IO_TYPE_Rx No I/O No I/O No I/O No I/O 8 DiscIn 4 

DiscOut

No I/O No I/O No I/O

Channel 

Group A

– – – – 1009 – – –

Channel 

Group B

– – – – 1019 – – –
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3 Create a FOUNDATION Fieldbus Network

3.1 Create a FF project

1 Start ControlCare Application Designer by clicking on the icon on your destop or via Start => 

Programs => Endress+Hauser => ControlCare => ControlCare Application Designer

2 The project starts from a blank application screen

– With the right mouse key select Project File=>New

1 The Document Type box appears: Click the option Project

2 The New Project dialog box opens:

1. Choose the folder where the project will be saved.

2. Type the name of the project in the File Name box.

3. Click Save. 

If the new project is not to be created, click Cancel.

3 ControlCare Application Designer automatically creates a folder with the entered file name 

within the selected folder.
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3.2 Determine the naming preferences

Before you start, you can set preferences for the way your project is created. Of particular interest 

at this stage is the labelling of the function blocks.

1 Press Project File => Preferences

– The Preferences Dialog appears

Tag Policy Tag Policy determines how the blocks are labelled by default if no tag names are entered

1 Select the folder Block and the subfolder Tag Policy, then check the following buttons

– Device

– Update Block Tag

2 Press OK to confirm your selection

– Application Designer will now automatically rename any blocks created in the control

strategy window as they are assigned to the devices by adding the device tag as prefix.

Tag Composition Tag Composition determines how the block identifiers are added to the block tag if no block name 

is entered.

1 Select the subfolder Tag Composition:

– Enter a mnemonic separator: for this manual the setting was "-"

Default setting is "_" and mandatory for if flexible function blocks are to be used

– Check Prefix

2 Press OK to confirm your selection

– Application Designer will now automatically compose the blocks according to your

selection, e.g. TagName-Block-n or TagName_Block_n.

Export Tag Export Tag causes tags to be automatically exported every time the project goes online

1 Select the subfolder Export Tag

– Check the Automatic button

– Press OK to confirm your selection

Strategy Strategy determines the default shape of the function block icons in the stratagy window and also 

whether the aliasing function is enabled

1 Select the subfolder Strategy

– Select the default shape for function block objects

– Select "Aliasing Input Dialog Box" 

– Press OK to confirm your selection
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3.3 Add a bridge (SFC162)

1 On saving, ControlCare Application Designer automatically creates a project, adding the HSE 

fieldbus network and the HSE Host

– Click on + to expand the tree:

2 Now right-click on the HSE Network leaf and select New=>Bridge

3 The New Bridge dialog box appears:

Select the SFC162 Field Controller and type in a device TAG, in our case FC_01

If you do not type in a tag, the default will be "Bridge n", where n is a consecutive number. 

4 Press OK to create the Bridge.

5 Repeat Steps 1 to 4 for as many SFC162 Field Controllers as you have in your network.
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3.4 Add a fieldbus segment

1 The project now looks like this:

2 Right click on the bridge you just created, here "FC_01", and select New Fieldbus.

3 The New Fieldbus dialog box appears:

– Enter a Fieldbus TAG, 

– Select the fieldbus port on the SFC162

– If you do not type in a tag, the default will be "Fieldbus n", where n is a consecutive number. 

4 Press OK to create the Fieldbus.

5 Open Project File, then press Save, to save the project.

6 Repeat Steps 1 to 5 for as many fieldbus segments as are in use.
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3.5 Add the devices

1 Click on the newly created Fieldbus 1 leaf and select Expand

2 A new work space Fieldbus 1 opens:

– Right-click on the Fieldbus 1 leaf and select New then Device

3 The New Device dialog appears

– Select the Device Manufacturer = Endress+Hauser

– Select the Device Type = TMT162

– Enter the Device Tag = TT100

If you do not type in a tag, the default will be "Device n", where n is a consecutive number 

– Press OK to create the device

Note! 

• Application Designer follows the latest DD and CF revisions by default. 

• If you are working with devices with older DD and CF revisions, uncheck the checkbox and select 

the correct Device Revision. 
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4 Your project now looks like this:

5 Repeat Steps 2 and 3 for the Micropilot M and the ND9103FN positioner

– Micropilot M:

Manufacturer = Endress+Hauser

Device Type = Micropilot M

Device Tag = LT101

– ND9103FN:

Manufacturer = Metso Automation

Device Type = Metso FBLK Interface

Device Tag = FCV102

– Note: If the flowmeters existed, they would now be added to the project with the tags FT103 

and FT104

6 Your project should now look like this:

7 Open Project File, then press Save, to save the project.
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3.6 Export tags

Note! 

• You should use the Export Tags function everytime you change the configuration of the project, 

so that the OPC server information is always up-to-date.

• Application Designer can be set up to automatically export tags everytime the system goes online, 

see Chapter 3.2

1 Active the project view by clicking in its workspace

2 Right click on the project name, a context menu appears

3 Select the option Export Tags...

– The Export Tags dialog confirms the successful export

– Press OK to close the dialog

4 Open Project File, then press Save, to save the project
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4 Create a Control Strategy

Having created a physical view of the process, the next step is to create control strategy. This is done 

in the logical view of the plant. This represents the plant as Areas/Process Cells in accordance with 

ISA S88/IEC 61518.

4.1 Add a Process Cell

1 Click on the "Area 1" leaf in the project and select Attributes...

2 The Attributes dialog box appears

– Enter a name for the area, e.g. Sterilization

– Click OK to store your changes

3 Click on the Area leaf again and select New Process Cell...

4 The Process Cell dialog box appears

– Enter a name for the process cell, e.g. Buffer tank

– Click OK to store your changes

5 Open Project File, then press Save Entire Configuration, to save the project.
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4.2 Add a Control Module

1 Right-click on the Process Cell leaf you just created and select Expand

1 A new window with the name of the leaf opens

– Right-click on the top leaf and select New Control Module

2 The Control Module dialog box appears

– Enter a name for the control module, e.g. Level control

– Click OK to store your changes

3 The project now looks something like this:

4 For a real project, Step 2 and 3 would be repeated until all the required control modules for a 

particular process cell have been added.

5 Open Project File, then press Save Entire Configuration, to save the project.
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4.3 Create the function blocks

Note! 

• The function blocks used in the tutorial are selected from the device manufacturer’s device list. 

It is also possible to select standard function blocks from the "Fieldbus Foundation" list. This 

ensures that the control strategy can be executed in any FF device that supports a particular 

standard block, irrespective of vendor.

• Endress+Hauser devices support standard function blocks and offer them in the manufacturer 

specific list.

1 Double-click on the control module leaf or right-click and select Expand to open the Control 

Strategy workspace - this has the same name as the leaf

2 Press the Function Block button  in the toolbar and click in the workspace

– The New Block dialog appears

– Select the Manufacturer = Endress+Hauser

– Select the Device Type = TMT162

– Select the Block Type = Analog Input

– Press OK to create the function block

3 The block now appears in the strategy window with the default name



ControlCare Application Designer: IEC 61131-3 Structured Text Tutorial 4 Create a Control Strategy

Endress+Hauser 21

4 Repeat Steps 2 and 3 for the following blocks

5 The control strategy now looks like this

6 Open Project File, then press Save Entire Configuration, to save the project.

Device Number Manufacturer Device Type Block Type

iTemp TMT162 1x Endress+Hauser TMT162 Analog Input (AI)

Micropilot M 1x Endress+Hauser Micropilot M Analog Input (AI)

ND9103FN 1x Metso Automatioin FBLK Interface Analog Output (AO)

SFC162 2x Endress+Hauser SFC162 Constant (CT)

2x Endress+Hauser SFC162 Analog Alarm (AALM)

1x Endress+Hauser SFC162 Multiple Discrete Input (MDI)

1x Endress+Hauser SFC162 Multiple Discrete Output (MDO)

1x Endress+Hauser SFC162 Hybrid With Mixed I/Os

(HY_EMB_IO)

1x Endress+Hauser SFC162 PID Control (PID)

1x Endress+Hauser SFC162 Cascade Characterizer (CCHAR)
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4.4 Add the Function Block Links

1 In the Control Strategy workspace position the blocks according to your strategy

– The blocks can be dragged and dropped by selecting and holding down the right mouse key

– The blocks can be aligned by selecting, then via Tools => Alignment => e.g. Middle 

followed by a click on the block to which the alignment is to be made

– The Tools menu also contains other standard drawing functions such as toolbars, standard 

shapes, line thickness, colours etc.

– Texts can be added to the strategy by opening the drawing toolbar via

Tools => Tool Boxes => Drawing then clicking on the "ABC" button and placing the 

cursor at the desired position in the strategy workspace

– The text font can be changed by activating the text box in the strategy and right clicking: 

Properties => Text Attributes => Font
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2 Click on Function Block Link  button in the tool bar, the cursor changes to a cross

– Select the Level control AI_1block: the Output Parameter Selection dialog appears

3 Click the box next to OUT – it changes color – then click on OK

– The Output Parameter Selection dialog closes

– The cursor is now connected to a blue dotted line

– Place the Cursor in the Level control CCHAR_1 block and click to make the link

4 When the link is made, the Input Parameter Selection dialog for the CCHAR block appears

Click the box next to IN_1 – it changes color – then click on OK

5 The Rename dialog now appears: for the 

– For the link between AI_1 and CCHAR_1 we have no alias, so press OK without making

an entry - the link retains the standard name

– For the links with an alias, enter the alias name then press OK

6 When the Rename dialog disappears, the link is made and appears as below:

– The link appears as a dotted line because the function block has yet to be attached to a device 

– The parameter legends "IN_1" and "OUT" by moved by drag & drop
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7 Repeat steps 2 to 5 and make the following links between the function blocks

– CCHAR1 and HY_EMB_IO_1 = OUT_1 to IN_2, Alias name: Product_Density

– AI_2 and AALM_1 = OUT to IN, No alias name

– AALM_1 and AALM_2 = OUT to IN, No alias name

– AALM_1 and HY_EMB_IO_1 = OUT_ALM to IN_D4, Alias name: LO_Level

– AALM_2 and HY_EMB_IO_1 = OUT_ALM to IN_D5, Alias name: HI_Level

– AALM_2 and HY_EMB_IO_1 = OUT to IN_1, Alias name: Product_Level

– MDI_1 and HY_EMB_IO_1 = OUT_D1 to IN_D1, Alias name: Tank_Overspill

– MDI_1 and HY_EMB_IO_1 = OUT_D2 to IN_D2, Alias name: Pump_Dry_Run

– MDI_1 and HY_EMB_IO_1 = OUT_D3 to IN_D3, Alias name: Emergency_Stop

– CT_2 and HY_EMB_IO_1 = OUT_1 to IN_3, Alias name: Flow_1

– CT_1 and HY_EMB_IO_1 = OUT_1 to IN_4, Alias name: Flow_2

– HY_EMB_IO_1 and PID_1 = OUT_1 to IN, Alias name: Level_Output

– HY_EMB_IO_1 and PID_1 = OUT_D3 to TRK_IN_D, Alias name: Close_Valve

– HY_EMB_IO_1 and MDO_1 = OUT_D1 to IN_D1, Alias name: Pump_1_Control

– HY_EMB_IO_1 and MDO_1 = OUT_D2 to IN_D2, Alias name: Pump_2_Contro

– PID_1 and AO_1 = OUT to CAS_IN, No alias name

– AO_1 to PID_1 = BKCAL_OUT to BKCAL_IN, No alias name

8 Since the input and output signals for a particular link now have the same names, you may 

want to hide some:

– Right click on the link, select Labels and click on the parameter you want to hide

– The label is hidden when there is no tick on the "Show...." parameter

9 Your Control Strategy now looks something like this (only outputs shown)

10 Open Project File, then press Save Entire Configuration, to save the project.



ControlCare Application Designer: IEC 61131-3 Structured Text Tutorial 4 Create a Control Strategy

Endress+Hauser 25

4.5 Configure the strategy

At this point we have a created a network with devices and a control strategy. In this section, we 

describe how the strategy is configured. You may prefer to configure the devices first, see Chapter 5, 

then the strategy. In strategies using many blocks and links you my decide that it is simpler to create 

and configure the devices and strategy piece by piece. Application Designer allows all these options.

4.5.1 Changing parameters

Procedure 1 Right click on the function block and select Offline Characterization

– The Offline Characterization dialog opens with a predefined list of parameters

– If required, the complete set of parameters can be viewed by pressing the All button

2 If necessary expand the parameter tree

– Double-click on the "Value space" next to the parameter

– Either select a parameter offered by the drop-down menu, or if no menu is present 

enter the parameter by hand

3 Press End Edit to register your change

– Cancel Edit will cancel the Edit and close the value space

– Clear will delete the selected parameter 

– When all parameters have been edited, press Close to close the dialog

Order of parameters Some block parameters have a write check based on the value of other parameters. It is therefore 

important to set the parameters in the order in which they are displayed in the Off Line 

Characterization dialog. After characterization of the block, the parameters will appear in the 

FOUNDATION Fieldbus and Process Cell trees. If you find a parameter in the wrong position, it can 

be move by dragging and dropping to the correct one. 



4 Create a Control Strategy ControlCare Application Designer: IEC 61131-3 Structured Text Tutorial

26 Endress+Hauser

4.5.2 Constant block (flow simulation)

In our tutorial, the flow meters will be simulated by two Constant blocks (CT1 and CT2), which 

represent the Analog Input blocks that would normally supply the measured values to the strategy. 

Each Constant block allows up to six analog values (floating point) and two discrete values (0, 1) to 

be simulated.

The parameters to be set are shown in Table 4-1 below, whereby any block parameters renamed 

during the creation of the strategy appear with their alias names:

Tab. 4-1: Parameters for Constant blocks

Note! 

• The block already contains the alias names of any link parameters renamed in the strategy

Procedure 1 In the Control strategy workspace, double-click on the Level control_CT_1 block

2 The Off Line Characterization dialog opens, see Chapter 4.5.1

– Expand the Mode Block node and set the Target to Auto

– Set CT_VAL_1 to 35

– Remember to press End Edit after every change

– When all parameters have been entered, press Close to quit the Characterization dialog

3 Repeat Steps 1 to 2 for the parameters in the Level control_CT_2 block, see table 4.1.

4 Open Project File, then press Save Entire Configuration, to save the project.

Parameter Function Value

Level Control_CT_1 (= Flow_1)

MODE BLOCK/TARGET Normal operating mode of block Auto

CT_VAL_1 Value to be output as OUT_1 by the constant block 35

Level Control_CT_2 (= Flow_2)

MODE BLOCK/TARGET Normal operating mode of block Auto

CT_VAL_1 Value to be output as OUT_1 by the constant block 48
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4.5.3 Analog Input (temperature)

The Analog Input function block Level control_AI_1 for the TMT162 must now be configured, 

see Table 4-2. A full description of the parameters is to be found in Operating Instructions 

BA224REN.

Tab. 4-2: Basic parameters for Analog Input blocks

Procedure 1 In the Control strategy workspace, double-click on the Level control_AI_1 block

2 The Off Line Characterization dialog opens, see Chapter 4.5.1

– Expand the Mode Block node and set the Target to Auto

– Expand the XD_SCALE node and enter the parameters in Table 4-2

– Expand the OUT_SCALE node and enter the parameters in Table 4-2

– Set Channel to Sensor Value 1

– Set L_TYPE to Indirect

– Remember to press End Edit after every change

– When all parameters have been entered, press Close to quit the Characterization dialog

3 Open Project File, then press Save Entire Configuration, to save the project.

Parameter Function Value

MODE BLOCK/TARGET Normal operating mode of block Auto

XD_SCALE/EU_100*

XD_SCALE/EU_0

XD_SCALE/UNITS_INDEX

Upper range value for process variable

Lower range value for process variable

Unit of process variable

100 (max.850)

0 (min. –200)

°C

OUT_SCALE/EU_100

OUT_SCALE/EU_0

OUT_SCALE/UNITS_INDEX

Upper range limit for output variable

Lower range limit for output variable

Unit of output variable

100

0

%

CHANNEL Output channel of TMT162 Transducer Block 

connected to Analog Input Block.

• Sensor Value 1: direct acquisition of temperature 

measured by thermoelement 1

Sensor Value 1

L_TYPE Selects the type of linearisation for the input value.

• Indirect: PV value scaled to OUT value

Indirect

*The range limits for the TMT162 temperature transmitter are determined by the transducer block parameters 

SENSOR_TYPE and PRIMARY_OUTPUT_TYPE. For SENSOR_TYPE = Pt100 and PRIMARY_OUTPUT_TYPE = SV_1 the 

transducer block outputs a temperature signal in the range -200°C to +850°C. The XD_SCALE and OUT_SCALE 

parameters generate the OUT value of the Anlaog Input block from any part of this range, in our case -50°C to 150°C. 
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4.5.4 Cascade Signal Characterizer (temperature/density)

The Cascade Signal Characterizer block Level control_CCHAR_1 allows the entry of a strapping 

table of up to 51 values for conversion of one variable to another, e.g. a linearization from % level 

to volume. The resolution of the characteristic curve can be increased by using several blocks in 

cascade.

In our case it will be used to calculate the density of the liquid at the measured temperature 

according to the table in Section 2.1.2. The density is then be used to calculate the mass of liquid 

in the tank. The parameters to be set are shown in Table 4-3, whereby any block parameters 

renamed during the creation of the strategy appear with their alias names:.

Tab. 4-3: Basic parameters for Cascade Characterization blcok

Note! 

• The temperature range in the table is 0°C to 100°C and corresponds exactly to the 0% to 100% 

signal output by the Level control AI_1 block. If a different range were required, the XD_SCALE 

and OUT_SCALE values of the AI block could be adjusted accordingly.

• The standard FOUNDATION Fieldbus block Signal Characterizer (SC) performs the same 

function, but has only 20 points and cannot be cascaded. The corresponding parameters are 

missing.

Parameter Function Value

MODE BLOCK/TARGET Normal operating mode of block Auto

X_RANGE/EU_100*

X_RANGE/EU_0

X_RANGE/UNITS_INDEX

Upper range value for input variable

Lower range value for process variable

Unit of process variable

100

0

%

Y_RANGE/EU_100

Y_RANGE/EU_0

Y_RANGE/UNITS_INDEX

Upper range limit for output variable

Lower range limit for output variable

Unit of output variable

1000

958.4

kg/m3

E_CURVE_X/[1]

E_CURVE_X/[2]

E_CURVE_X/[3]

E_CURVE_X/[4]

E_CURVE_X/[5]

E_CURVE_X/[6]

E_CURVE_X/[7]

E_CURVE_X/[8]

E_CURVE_X/[9]

E_CURVE_X/[10]

E_CURVE_X/[11]

E_CURVE_X/[12]

X values (input variable) of strapping table

• Values must rise or fall monotonically

• Values must be within the range defined by 

X_RANGE

• Unedited values are automatically set to infinity, 

which means they are not used

0 (%)

4

10

20

30

40

50

60

70

80

90

100

E_CURVE_Y/[1]

E_CURVE_Y/[2]

E_CURVE_Y/[3]

E_CURVE_Y/[4]

E_CURVE_Y/[5]

E_CURVE_Y/[6]

E_CURVE_Y/[7]

E_CURVE_Y/[8]

E_CURVE_Y/[9]

E_CURVE_Y/[10]

E_CURVE_Y/[11]

E_CURVE_Y/[12]

Y values (input variable) of strapping table^

• Exacly the same number of values must be entered as 

for the X_CURVE

• Values must be within the range defined by 

Y_RANGE

• Unedited values are automatically set to infinity, 

which means they are not used

999.9 (kg/m3)

1000

999.7

998.2

995.7

992.2

988.1

983.1

977.8

971.8

965.3

958.4

CAS_CONTROL Determines whether the block is cascaded with others 

and what position it has in the chain

• None: block is used on its own

None
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Procedure 1 In the Control strategy workspace, double-click on the Level control_CCHAR_1 block

2 The Off Line Characterization dialog opens, see Chapter 4.5.1

– Expand the Mode Block node and set the Target to Auto

– Expand the XD_SCALE node and enter the parameters in Table 4-3

– Expand the OUT_SCALE node and enter the parameters in Table 4-3

– Expand the E_CURVE_X node and enter the parameters in Table 4-3

– Expand the E_CURVE_Y node and enter the parameters in Table 4-3

– Click on CAS_CONTROL and select None from the drop-down menu

– Remember to press End Edit after every change

– When all parameters have been entered, press Close to quit the Characterization dialog

3 Open Project File, then press Save Entire Configuration, to save the project.Basic PID 

parameters
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4.5.5 Analog Input (level)

The Analog Input function block Level control_AI_2 for the Micropilot M must now be 

configured, see Table 4-4. A full description of the parameters is to be found in the FOUNDATION 

Fieldbus Operating Instructions for the Micropilot M BA278F/00/en.

Tab. 4-4: Basic parameters for Analog Input blocks

Procedure 1 In the Control strategy workspace, double-click on the Level control_AI_1 block

2 The Off Line Characterization dialog opens, see Chapter 4.5.1

– Expand the Mode Block node and set the Target to Auto

– Expand the XD_SCALE node and enter the parameters in Table 4-2

– Expand the OUT_SCALE node and enter the parameters in Table 4-2

– Set Channel to Measured value

– Set L_TYPE to Indirect

– Remember to press End Edit after every change

– When all parameters have been entered, press Close to quit the Characterization dialog

3 Open Project File, then press Save Entire Configuration, to save the project.

Parameter Function Value

MODE BLOCK/TARGET Normal operating mode of block Auto

XD_SCALE/EU_100*

XD_SCALE/EU_0

XD_SCALE/UNITS_INDEX

Upper range value for process variable

Lower range value for process variable

Unit of process variable

100

0

%

OUT_SCALE/EU_100

OUT_SCALE/EU_0

OUT_SCALE/UNITS_INDEX

Upper range limit for output variable

Lower range limit for output variable

Unit of output variable

100

0

%

CHANNEL Output channel of Micropilot Transducer Block 

connected to Analog Input Block.

• Measured value: level as measured according to full 

and empty calibration

Measured value

L_TYPE Selects the type of linearisation for the input value.

• Indirect: PV value scaled to OUT value

Indirect



ControlCare Application Designer: IEC 61131-3 Structured Text Tutorial 4 Create a Control Strategy

Endress+Hauser 31

4.5.6 Analog Alarm (level)

The Analog Alarm function blocks Level control_AALM_1 and Level control_AALM_2 for the 

Micropilot M must now be configured, see Table 4-5, whereby any block parameters renamed 

during the creation of the strategy appear with their alias names. These blocks monitor the incoming 

level signal. If the signal drops below a LO or LO_LO limit, the OUT_ALM signal changes from 

FALSE to TRUE (Level control_AALM_1). If the signal exceeds a HI or HI_HI limit, the 

OUT_ALM signal changes from FALSE to TRUE (Level control_AALM_2). The change from 

FALSE to TRUE can be used by a downstream block to initiate some process, in our case to switch 

off the pumps or close the valve, see Chapter 2.1.2.

In order to avoid flutter due to changes in level around the switching points, an alarm hysteresis is 

set. Thus OUT_ALM will switch from FALSE to TRUE when the level drops below 30%, but will 

not switch back from TRUE to FALSE until the level has reached 32%. For the HI limit, the 

corresponding values are 80% and 78% respectively.

Tab. 4-5: Basic parameters for Analog Input blocks

Procedure 1 In the Control strategy workspace, double-click on the Level control_AALM_1 block

2 The Off Line Characterization dialog opens, see Chapter 4.5.1

– Expand the Mode Block node and set the Target to Auto

– Select the OUT_ALM_SUM node and select LO from the drop-down menu

– Set ALARM_HYS to 2

– Set LO_LIM to 30

3 Repeat the procedure for Level control_AALM_2 using the parameters in Table 4-5

4 Open Project File, then press Save Entire Configuration, to save the project.

Parameter Function Value

Level control_AALM_1

MODE BLOCK/TARGET Normal operating mode of block Auto

OUT_ALM_SUM Alarms to be monitored in the alarm summary LO

ALARM_HYS Alarm hysteresis as percentage of span 2 (%)

LO_LIM Value of LO limit in units of the incoming variable 30 (%)

Level control_AALM_2

MODE BLOCK/TARGET Normal operating mode of block Auto

OUT_ALM_SUM Alarms to be monitored in the alarm summary HI

ALARM_HYS Alarm hysteresis as percentage of span 2 (%)

HI_LIM Value of HI limit in units of the incoming variable 80 (%)
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4.5.7 Multiple Discrete Input block (level limits, emergency stop)

The MDI block connects the signals from the SFC432 Discrete Input/Output module to the control 

strategy. This delivers FALSE for a 0 VDC signal and TRUE for a 24 VDC signal. The channel 

parameter is that in Table 2-1, Chapter 2.2.2. Any block parameters renamed during the creation 

of the strategy appear with their alias names.

Tab. 4-6: Basic parameters for Multiple Discrete Input block

Procedure 1 In the Control strategy workspace, double-click on the Level control_MDI_1 block

2 The Off Line Characterization dialog opens, see Chapter 4.5.1

– Expand the Mode Block node and set the Target to Auto

– Set CHANNEL to 1009

3 Open Project File, then press Save Entire Configuration, to save the project.

Parameter Function Value

MODE BLOCK/TARGET Normal operating mode of block Auto

CHANNEL Signal channel: Rack, Slot, Group, 9 = all inputs 1009
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4.5.8 Hybrid Embedded I/O block

The HY_EMB_IO block adds the logic to the control strategy. It contains a flexible function block 

which connects the various inputs to its outputs via a logical algorithm that may be programmed in 

any of the IEC 61131-3 function block langúages. The programming is described in Chapter 5. 

At this point only the MODE_BLK target should be set.

Tab. 4-7: Basic parameters for Multiple Discrete Input block

Procedure 1 In the Control strategy workspace, double-click on the Level control_MDI_1 block

2 The Off Line Characterization dialog opens, see Chapter 4.5.1

– Expand the Mode Block node and check that the Target is set to Auto

– Set the parameter HYB_STATUS_OPS to None

In the excercise, the status of the outputs will be be considered in the ST program.

If this is not the case, the parameter should be set to Set Ouputs to Good Non Cascade

3 Open Project File, then press Save Entire Configuration, to save the project.

Parameter Function Value

MODE BLOCK/TARGET Normal operating mode of block Auto

HYB_STATUS_OPTS Sets status options of IEC 61131-3 variables

• None: the status will be set within the block

• Set Outputs to Good Non Cascade: all outputs will be 

automatically set to good, ifrrespective of input

None

EXEC_TIME_TARGET Target time for execution of the hybrid block 30 ms (default)
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4.5.9 Multiple Discrete Output block

The MDO block is attached to the SFC432 Discrete Input/Output module to which the pump 

power is connected. The SFC432 has normally closed (NC) relays. A FALSE (=0) signal causes the 

relay to open and the pump stops. A TRUE (=1) signal causes the relay to close and the pump starts. 

In the event of a power failure, the pump fails to safe = stop. The channel parameter is that in 

Table 2-1, Chapter 2.2.2. Any block parameters renamed during the creation of the strategy appear 

with their alias names.

Tab. 4-8: Basic parameters for Multiple Discrete Input block

Procedure 1 In the Control strategy workspace, double-click on the Level control_HY_EMB_IO_1 block

2 The Off Line Characterization dialog opens, see Chapter 4.5.1

– Expand the Mode Block node and set the Target to Auto

– Set CHANNEL to 1019

3 Open Project File, then press Save Entire Configuration, to save the project.

Parameter Function Value

MODE BLOCK/TARGET Normal operating mode of block Auto

CHANNEL Signal channel: Rack, Slot, Group, 9 = all outputs 1019
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4.5.10 PID Control (level control of valve)

The Field Controller PID blocks must now be characterized. In practice, the values for the GAIN, 

RESET and RATE as well as the setpoint value SP for the level loop will be known. The other values 

determine the way the control is handled when the block moves from Auto/Cas to Man or another 

mode or when a process value has a bad status. See also ControlCare Function Block manual 

BA022S/04/en.

In case of an emergency stop or dry run, we want the valve to close. This is done by overriding the 

automatic mode and forcing the valve to close. To this end, output tracking must be enabled in the 

CONTROL_OPS parameter and the appropriate ranges and value set for the TRK parameters. Now 

when the TRK_IN_D signal is true, the valve is forced into the TRK_VAR position.

Note! 

• The TRK_IN_D parameter has alias name "Close_Valve", since it was renamed in the strategy

Tab. 4-9: Basic parameters for temperature and flow PID blocks

Parameter Function Value

MODE BLOCK/TARGET Normal operating mode of block Auto

SP/VALUE Setpoint for ideal level 60%

PV_SCALE/EU_100

PV_SCALE/EU_0

PV_SCALE/UNITS_INDEX

Upper range limit for process variable

Lower range limit for process variable

Unit of process variable

100

0

%

OUT_SCALE/EU_100

OUT_SCALE/EU_0

OUT_SCALE/UNITS_INDEX

Upper range limit for output variable

Lower range limit for output variable

Unit of output variable

100

0

%

CONTROL_OPTS Sets control options for bad input

Enables output tracking 

Bypass Enable

Track Enable

STATUS_OPTS Sets the way the status of the tracking value is used Use uncertain as good

BYPASS When ON, SP value is transferred to the OUT without 

the calculation of PID terms. 

OFF

SP_RATE_DN

SP_RATE_UP

Rate of change from old to new, higher SP

Rate of change from old to new, lower SP

0

0

GAIN

RESET

RATE

Tuning constants for the P, I and D terms, of the PID 

block respectively.

1.5

0.1 s

0.5 s

SHED_OPT Behaviour when shedding from remote mode Normal shed, normal 

return 

TRK_SCALE/EU_100

TRK_SCALE/EU_0

TRK_SCALE/UNITS_INDEX

Upper range limit for tracking variable

Lower range limit for tracking variable

Unit of tracking variable

100

0

%

TRK_VAL/STATUS

TRK_VAL/VALUE

Status to be sent with tracking value

Value to be forced on OUT, 0 = closed

GoodCascade:Local

0
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Procedure 1 In the Control strategy workspace, double-click on the Level control_PID_1 block

2 The Off Line Characterization dialog opens, see Chapter 4.5.1

– Press the All button to reveal all parameters

– Expand the Mode Block node and set the Target to Auto

– Expand the SP node and set the SP_VALUE to 60

– Expand the PV_SCALE node and enter the parameters in Table 4-9

– Expand the OUT_SCALE node and enter the parameters in Table 4-9

– Click on CONTROL_OPS and tick Bypass Enable and Track Enable from the 

drop-down menu

– Click on STATUS_OPS and tick Use uncertain as Good from the drop-down menu

– Click on BYPASS and select OFF from the drop-down menu

– Click on SP_RATE_DN and set to zero

– Click on SP_RATE_UP and set to zero

– Click on GAIN and set to 1.5

– Click on RESET and set to 0.1

– Click on RATE and set to 0.5

– Click on SHED_OPT and select NormalShed:NormalReturn from the drop-down menu

– Expand the TRK_SCALE node and enter the parameters in Table 4-9

– Expand the TRK_VAR node and enter the parameters in Table 4-9

– Remember to press End Edit after every change

– When all parameters have been entered, press Close to quit the Characterization dialog

3 Open Project File, then press Save Entire Configuration, to save the project.
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4.5.11 Analog Output (valve positioner)

The Analog Output block Level control_AO_1 for the ND9103FN now has to be configured. The 

basic parameters required are shown in Table 4-10. A full description of the parameters are to be 

found in the Operating Instructions

•  ND9000F Users Guide, downloadable from www.metso.com

Tab. 4-10: Basic parameters for Analog Output block

Procedure 1 In the Control strategy workspace, double-click on the Level control_AO_1 block

2 The Off Line Characterization dialog opens, see Chapter 4.5.1

– Expand the Mode Block node and set the Target to Auto

– Expand the PV_SCALE node and enter the parameters in Table 4-10

– Expand the OUT_SCALE node and enter the parameters in Table 4-10

– Click on CHANNEL and select AO: valve control (not writable if DO channel active) 

from the drop-down menu

– Click on SHED_OPT and select NormalShed:NormalReturn from the drop-down menu

– Remember to press End Edit after every change

– When all parameters have been entered, press Close to quit the Characterization dialog

Tab. 4-11: Open Project File, then press Save Entire Configuration, to save the project.

Parameter Function Positioner 

FCV102

MODE BLOCK/TARGET Normal operating mode of block Cas

PV_SCALE/EU_100

PV_SCALE/EU_0

PV_SCALE/UNITS_INDEX

Upper range limit for process variable

Lower range limit for process variable

Unit of process variable

100

0

%

XD_SCALE/EU_100

XD_SCALE/EU_0

XD_SCALE/UNITS_INDEX

Upper range limit for output variable

Lower range limit for output variable

Unit of output variable

15

3

psi

CHANNEL Defines the signal configuration between the AO block and 

transducer block.

AO: valve control 

(not writable if DO 

channel active)

SHED_OPT Behaviour when shedding from remote mode Normal shed, normal 

return 
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4.6 Store the strategy as a template

FOUNDATION Fieldbus offers the possibility of storing complete control strategies as fully 

configured generic templates. This is especially useful when particular control strategies occur 

several times within a project. The strategies are stored independent of device assignment, which is 

performed as a separate step. The IEC 61131-3 algorithm is not stored in the template.

After configuration, the strategy can be stored as a template for similar applications using the same 

devices.

1 In the Strategy workspace, drag the mouse across the complete strategy with the left button 

depressed, until all function blocks are selected

2 Now press the Strategy Export button  in the toolbar

– The Save As dialog appears

– If appropriate, browse to another folder

– Enter a File Name

– Press Save to save the strategy

3 The strategy can be imported again pressing the Strategy Import button  in the toolbar and 

double-clicking on the appropriate file name.
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4.7 Attach the Function Blocks to the devices

Now attach the function blocks in the control strategy to the devices where they are to run. The 

order of attachment determines the order of execution in the Field Controller and FF devices.

•  First attach the input blocks

•  Then attach the control and logic blocks in the order of execution

•  Finally attach the output blocks

If necessary, the order of the blocks can be adjusted by drag & drop.

1 Expand the Fieldbus workspace (Fieldbus 1) and the Process Cell workspace (Heat 

exchanger) 

– Note that the Buffer Tank tree now contains all the function blocks that you created in the 

Control Strategy workspace. 

– A question mark in a block means that the block has still to be attached to a device.

2 Now drag and drop the Level control_AI_1 block to the greyed Function Block Application 

leaf of the TT100 tree

– When you drop the block, it is attached to tree

– Its name changes to TT100-AI-1 in both views

– You have now assigned the Temperature AI block to the temperature transmitter

3 Repeat Step 2 for the other function blocks, dragging them across in the required order of 

execution:

– Level control_AI_2 => LT101

– Level control_CT_1 => FC_01

– Level control_CT_2 => FC_01

– Level control_AALM_1 => FC_01

– Level control_AALM_2 => FC_01

– Level control_CCHAR_1 => FC_01

– Level control_MDI_1 => FC_01

– Level control_HY_EMB_IO_1 => FC_01

– Level control_PID_1 => FC_01

– Level control_MDO_1 => FC_01

– Level control_AO_1 => FCV102
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4 Your project now looks like this

and the strategy looks like this:

5 Click on the Project View workspace and Export Tags..., see Chapter 3.5

6 Open Project File, then press Save Entire Configuration, to save the project.

Note! 

• Function blocks can also be attached to devices by right-clicking on the FB VFD or FBAP node of 

the appropriate device in the Fieldbus workspace and selecting Attach Block...
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5 Parameter the Devices

It is important to remember that the device parameters in the Transducer Block are an integral part 

of any FOUNDATION Fieldbus project. This has consequences in the way the devices can be 

parametered:

•  The most secure method is to parametrize offline with the Application Designer - this ensures 

that you are downloading a complete set of parameters to the devices

•  For devices with display operation or a service interface, it is possible to parametrize at the 

device itself. If you wish to parametrize by this method, it is important that only the Mode 

Block Target is parametrized in Application Designer. 

•  If the device has a HistoROM, this must be activated in the offline configuration, otherwise the 

device will show a HistoROM error after the download.

•  Application Designer does not support device parameter upload at the moment: this means that 

if you have used a service tool or the display to parametrize, the device parameters are not 

stored centrally in the project. A device failure means that the replacement device has to 

parametrized anew. This can be avoided by ensuring that the parameters are downloaded to 

the DAT or HistoROM, or by manually transferring the parameters displayed in the Online 

Characterization to the Offline Characterization dialog

This tutorial tells you how to parametrize offline with Application Designer. but it is also possible to 

parametrize online.

Order of parameters Some block parameters have a write check based on the value of others parameters. It is therefore 

important to set the parameters in the order shown in the various tables, i.e. the same order in 

which they are displayed in the Off Line Characterization dialog. 

After parametrization of the block, the parameters will appear in the FOUNDATION Fieldbus tree. 

If you find a parameter in the wrong position, it can be move by dragging and dropping to the correct 

one.

5.1 Field Controller Hardware Configuration block

1 Double click on the HSE Network leaf, the HSE Network window opens:

– Expand the FC_01 and FBAP leaves

2 Double-click on the FC_01_HC_1 leaf to open the Off Line Characterization dialog

To change parameters, see Chapter 4.5.1: 

– Expand the parameter leaf

– Double click on value space

– Enter the parameter or select it from the drop-down menu

– Confirm with End Edit
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3 Expand the MODE_BLK parameter left and check that Target is set to Auto

4 Expand the IO_TYPE_R0 parameter leaf and set the following parameters, see Table 2-1, 

Chapter 2.2.2

– Slot_0: No I/O

– Slot_1: No I/O

– Slot_2: No I/O

– Slot_3: No I/O

5 Expand the IO_TYPE_R1 parameter leaf and set the following parameters, see Table 2-1, 

Chapter 2.2.2

– Slot_0: 8 DiscIn 4 DiscOut

– Slot_1: No I/O

– Slot_2: No I/O

– Slot_3: No I/O

6 Click Close, then save the configuration 

– Right-click on the Project File menu and select Save Entire Configuration to save the

project, which now looks like this.
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5.2 TMT162 temperature transmitter

Full details of how to parametrize the TMT162 temperature transmitter are to be found Operating 

Instructions BA224R/06/en, which can be downloaded from www.endress.com. Table 5-1 shows 

the basic parameters that must be set in the TMT162 TEMP_1 transducer block

Tab. 5-1: Basic parameters for TMT162 transducer block

Procedure 1 In the Fieldbus network workspace, expand the TT100 tree until the function blocks are visible

– Right click on the TT100-TEMP-1 block and select Off Line Characterization...

2 The Off Line Characterization dialog opens

– Expand the Mode Block parameter tree and set Target to Auto. 

– Set PRIMARY_VALUE_TYPE = PV = Sensor value 1 (SV1)

– Set SENSOR_TYPE = Pt 100 IEC (a=3.85 E-03)

– Set SENSOR_CONNECTION = 2-wire

– Remember to press End Edit after every change

– Press Close to quit the Characterization dialog

3 Open Project File, then press Save Entire Configuration, to save the project.

Parameter Function Temperature 

TT100

MODE BLOCK/TARGET Normal operating mode of block Auto

PRIMARY_VALUE_TYPE Calculation method for primary process value

• Process temperature SV1 or SV2

• Average 0.5 (SV1 + SV2) with/without redundancay

• Differential (SV1 - SV2)

• Conditional (SV1 or SV2), (SV2 if SV1 >T)

Sensor Value 1

SENSOR_TYPE Type of sensor connected to the transmitter

• All types of standardized temperature sensors

Pt 100 IEC 751

SENSOR_CONNECTION Way in which the sensor is connected

• 4-wire (if two sensors are connected only one can be 4-wire)

• 3-wire

• 2-wire

2-wire
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5.3 Micropilot M level transmitter

Full details of how to parametrize the Micropilot M level transmitter are to be found Operating 

Instructions BA278F/00/en, which can be downloaded from www.endress.com. Table 5-2 shows 

the parameters that must be set in the Micropilot M transducer block.

Note! 

• Currently, Endress+Hauser level devices do not support offline parametrization within 

Application Designer. The procedures described here must be performed online, preferrably after 

the allocation of the Device ID, but before download of the project.

• In the case of time-of-flight devices, i.e. Micropilot, Levelflex, Prosonic, the tank must be mapped 

and the measurement checked when the device is online.

Fig. 5-1 shows the basic calibration parameters. For all other parameters the default values will be 

accepted,i.e. in our case the default value for suppression distance (SD) will be used, i.e. the 

associated parameter PARSUPPRESSIONDISTANCE will not be changed (default = 0.1 m).

The parametrization procedure is described in Chapter 7.3.4.

Fig. 5-1:  Calibration parameters of Micropilot M level transmitter

Tab. 5-2: Basic parameters for Micropilot M transducer block
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Parameter Function Value

MODE BLOCK/TARGET Normal operating mode of block

• During online parametrization this must be set to OOS

• After parameterization reset to Auto

Auto

PAROPERATIONCODE Sets the parameters to RW in on-line operation 2457

PARTANKSHAPE Configures the application for tank shape, bypass, stilling well flat ceiling

PARDIELECTRICCONSTANT Sets the dielectric constant of the liquid to be measured D.C. 1.9 - 4

PARPROCESSCONDITIONS Configures the device to conditions within tank calm surface

PAREMPTYCALIBRATION Distance from top of Micropilot process connection to desired 

zero level of tank – Parameter E in Fig. 5-1

e.g. 3.5

PARFULLCALIBRATION Distance from selected zero level to desired 100% level of tank 

– Parameter F in Fig. 5-1

e.g. 3.0
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5.4 Metso ND9103FN positioner

Full details of how to parametrize the Metso ND9103FN valve positioner are to be found in the 

ND900F User Guide which can be downloaded from www.metso.com.

In the tutorial, you have probably only the valve positioner, but not the valve itself. In real life, the 

positioner must be told what it is driving and certain assembly information must always be entered 

into the transducer block. The rotary valve parameters are included in Table 5-3. For instructions 

on how all other parameters can be used, see the User Guide. 

Tab. 5-3: Basic parameters for ND9103FN positioner transducer block

Procedure 1 In the Fieldbus network workspace, expand the FCV102 tree until the function blocks are 

visible

– Right click on the FCV102_BLK_2 block and select Off Line Characterization...

2 The Off Line Characterization dialog opens

– Expand the Mode Block parameter tree and set Target to Auto

– Set VALVE_TYPE = Rotary

– Set POSITIONER_FAIL_ACTION = Close

– SET CT_TYPE = Double-acting actuator

– Press Close to quit the Characterization dialog

3 Open Project File, then press Save Entire Configuration, to save the project.

Parameter Function Positionere 

FCV102

MODE BLOCK/TARGET Normal operating mode of block Auto

VALVE_TYPE Type of valve the positioner is actuating

• Select from drop-down menu

Rotary

FINAL_VALUE_RATE_DN Maximum travel rate in closing direction

• 0 = parameter not in use

0

FINAL_VALUE_RATE_UP Maximum travel rate in opening direction

• 0 = parameter no in use

0

POSITIONER_FAIL_ACTION Action of position on loss of electrical power or reception of an 

output signal with a bad status

• Select from drop-down menu

Close

POS_SENSOR_ROT Relationship between valve action and position sensor rotation

• Select from drop-down menu

Standard: 

Clockwise to close

DEAD_ANGLE_COMP Dead angle for segment and rotary valves 0

ACT_TYPE Type of positioner action 

• Select from drop-down menu

Double-acting 

actuator

PERFORMANCE_LEVEL Target performance level of valve position control

Select from drop-down menu

Optimum

CHAR_TYPE Type of linearization

• Select from drop-down menu

No characterization
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5.5 Export tags

Note! 

• You should use the Export Tags function everytime you change the configuration of the project, 

so that the OPC server information is always up-to-date.

• Application Designer can be set to automatically export the tags every time the project goes 

online, see Chapter 3.2.

1 Activate the project view by clicking in its workspace

– Right click on the project name, a context menu appears

2 Select the option Export Tags...

– The Export Tags dialog confirms the successful export

– Press OK to close the dialog

3 Open Project File, then press Save Entire Configuration, to save the project.
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6 Program the Hybrid Function Block

6.1 Set the IEC 61131-3 programming language

1 In the HSE Network 1 tree, right click on FC_01_HY_EMB_IO_1 and select Attributes

2 The Attributes dialog opens:

– In the IEC 61131-3 Programming Language menu select ST (Structured Text)

– Tick the box "Map as FF Data Structure"

– Press OK to confirm the selection



6 Program the Hybrid Function Block ControlCare Application Designer: IEC 61131-3 Structured Text Tutorial

48 Endress+Hauser

6.2 Program the hybrid function block

6.2.1 OpenPCS programming tool

1 In the HSE Network 1 tree, right click on FC_01_HY_EMB_IO_1 and select 

Program Hybrid Block

2 The OpenPCS programming tool opens:

– The Files pane of the Project window shows the program files

– The Resources pane shows the hybrid block task attached to the Field Controller

– The Lib pane shows the libraries available

– The Help pane opens the Online help tree

– The Catalog window might also appear – it can be closed by pressing the "x"

– The Log window tracks program events – it can be closed by pressing the "x"



ControlCare Application Designer: IEC 61131-3 Structured Text Tutorial 6 Program the Hybrid Function Block

Endress+Hauser 49

3 Double-click on FC_01_HY_EMB_IO_1.ST: the editor opens with the declared external 

variables (the log window at the bottom was closed for this screenshot)

– The upper right-hand pane contains the external variables we just declared, Chapter 6.1

– The lower right-hand pane contains the structuctured text program, which is empty 

on starting
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6.2.2 Declare additional variables

Additional variables used by the structured text program must be declared with name and data type 

in the upper right-hand pane before programming starts. Table 6-1 lists the various types of 

declaration supported. The declaration opens with the variable type and is closed with END_VAR. 

The various types are created with default value zero for real and integer variables and FALSE for 

booleans. 

Tab. 6-1: Variable declaration types

Attributes The declarations can be modified to define a particular behaviour of the variables contained within 

them by adding one of the attributes in Table 6.2.

Tab. 6-2: Declaration attribute types

Example For this exercise, we will declare the boolean "Reset_Pump_Start_Counter" as an OPC variable to 

enable a SCADA program to reset the variable "Number_Pump_Starts" to zero. It begins with the 

status "0" = "FALSE"

In order to detect the change from TRUE (stop) to FALSE (start) for the variables Pump_1_Control 

and Pump_2_Control, we need to determine the state at the last execution of the block. For this 

we require two variables State_Pump_1 and State_Pump_2 that are retained should the controller 

be switched off. Since they are to be compared with FF variables, they must be declared as FF 

discrete values, i.e. DS 66. Real values have the format DS 65.

Finally the integer Number_Pump_Starts must be readable in the IEC OPC server and retained 

should the controller be switched off (power down).

Variable type Access Rights Function

External Internal

VAR – RW Local variable that is readable and writable to its own block only

VAR_INPUT RW R Input variable that is readable and writable to an external block, but 

only readable to its own block

VAR_OUTPUT R RW Output variable that is readable and writable to its own block, but only 

readable to an external block

VAR_IN_OUT RW RW I/O variable readable and writable to its own and an external block

(call be reference)

VAR_EXTERNAL RW RW External I/O variable, declared as global in its own block, that is 

readable and writable to its own and an external block, whereby any 

change is immediately effective in all blocks where it is used

VAR_GLOBAL RW RW Global I/O variable, declared as external in its own block, that is 

readable and writable to it own and an external block, whereby any 

change is immediately effective in all blocks where it is used

VAR_ACCESS RW RW Global I/O variable (access path) that is readable and writable in its 

own and an external block resident in a different controller, whereby 

any change is immediately effective in all blocks where it is used

Attribute type Function

RETAIN Variable that retains its value when the controller is switched off or restarted

CONSTANT Variable that retains a constant value, i.e. not writable

OPC Variable that is readable and writable in the IEC OPC Server

– Local varibles declared with the prefix OPC_ are also visible in the IEC OPC server
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Procedure In the upper right-hand pane do the following:

1 Declare Pump_Start_Counter_Reset as boolean and an IEC OPC Server variable

VAR OPC

 Pump_Start_Counter_Reset: BOOL;

END_VAR

2 Declare the two retained booleans State_Pump_1 and State_Pump_2

VAR RETAIN

State_Pump_1: DS_66;

State_Pump_2: DS_66;

END_VAR

3 Declare the integer Number_Pump_Starts as retained and an IEC OPC Server variable

VAR RETAIN OPC

Number_Pump_Starts: INT;

END_VAR

Note! 

• An alternative method to declare IEC OPC Server variables not used in this tutorial 

is to add the OPC_ prefix:

VAR

OPC_Pump_Start_Counter_Reset: BOOL;

END_VAR

VAR_RETAIN

OPC_Number_Pump_Starts: INT;

END_VAR
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6.2.3 Activate the libraries

The FF variables used in IEC 61311-3 programming must be converted to a data type appropriate 

to programming language. To this end ControlCare activates two libraries by default:

•  CC_FF_CUSTOM_LIB to map the custom FF function blocks

(Data type conversion DS65, DS66)

•  CC_FF_STANDARD_LIB to map the standard FF function blocks

(FF status handling)

These appear red in the library pane (select the Lib tab)

Note! 

• For ControlCare Product Version 2.01.xx, the libraries have to be activated by hand

• For SFC programming the sfclib must be activated, see below and the OpenPCS online help

Activating a library In order to activate additional libraries, e.g. sfclib for SFC programming, the following procedure is 

used:

1 Select the Lib pane:

– Right-click on e.g sfclib and select Use in Current Project

– The project book turns red = active

Installing a library If the libraries are not installed:

1 Right-click on Libraries, select Install New..., 

2 Browse to the folder containing the LIB files and select the library required

3 Press OK twice to install.
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6.2.4 Create the structured text program

For simplicity, the structured text program will be written 

•  first for the pump and valve control

•  then for the calculation of the measured values

•  finally for the pump start counter. 

The conditions for the discrete logic are as follows:

•  Overspill protection, dry run protection and emergency stop to DI-0 to DI-2 inputs of a Field 

Controller SFC432 Mixed Discrete I/O module: 0 V = False, 24 V = True

•  Pump output current from DO-0 and DO-1 outputs of the Field Controller SFC432 Mixed 

Discrete I/O module: NO relay, 0 = Pump OFF, 1 = Pump ON, Fail Safe = Pump OFF

The strategy is created according to the truth table in Chapter 2.1.2.

Pump and valve control 1 Enter the following text in the lower right-hand pane:

(*HI_HI and LO_LO level handling*)

IF Tank_Overspill.value = 1 THEN

Pump_1_Control.value := 0; (*Pump OFF*)

Pump_2_Control.value := 0; (*Pump OFF*)

END_IF;

IF Pump_Dry_Run.value = 1 THEN

Close_Valve.value := 1; (*Valve CLOSED, TRACK_IN_D = TRUE*)

END_IF;

IF Operator_Entry_Emergency.value = 1 OR Emergency_Stop.value = 1 THEN

Pump_1_Control.value := 0; (*Pump OFF*)

Pump_2_Control.value := 0; (*Pump OFF*)

Close_Valve.value := 1; (*Valve CLOSED, TRACK_IN_D = TRUE*)

END_IF;

(*HI and LO level handling*)

IF HI_Level.value = 1 THEN

Pump_1_Control.value := 0; (*Pump OFF*)

Pump_2_Control .value:= 0; (*Pump OFF*)

ELSIF Operator_Entry_Emergency.value = 0 

AND Emergency_Stop.value = 0 

AND Tank_Overspill.value = 0 THEN

Pump_2_Control.value := 1; (*Pump ON*)

END_IF;

IF LO_Level.value = 1 THEN

Close_Valve.value:= 1; (*Valve CLOSED, TRACK_IN_D = TRUE*)

Pump_1_Control.value := 1; (*Pump ON*)

ELSIF Operator_Entry_Emergency.value = 0 

AND Emergency_Stop.value = 0 

AND Pump_Dry_Run.value = 0 THEN

Close_Valve.value:= 0; (*Valve OPEN, PID control*)

END_IF;

(*Set status to good, e.g. GoodNC NonSpecific = 128*)

Pump_1_Control.status := 128;

Pump_2_Control.status := 128;

Close_Valve.status := 128;
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Measured values 2 Now perform the calculations as shown in Chapter 2.1.2

(*Product mass = Product volume x Product density, Level = Level value from Micropilot*)

Product_Mass.value := 66.0*Product_Level.value*Product_Density.value/700.0;

Level_Output.value := Product_Level.value;

(*Total flow*)

Total_Flow.value := Flow_1.value + Flow_2.value;

(*Status propagation, 64 = Uncertain NonSpecific*)

Level_Output.status := Product_Level.status;

IF Product_Level.status := Product_Density.status THEN

Product_Mass.status := Product_Level.status;

ELSE Product_Mass.status := 64;

END_IF;

IF Flow_1.status = Flow_2.status THEN

Total_Flow.status := Flow_1.status;

ELSE Total_Flow.status := 64;

END_IF;

Pump start counter 3 The counter is now set up 

(*If Pump_Start_Counter_Reset is true, the counter is set to zero*)

IF Pump_Start_Counter_Reset THEN

Number_Pump_Starts := 0;

Pump_Start_Counter_Reset := 0;

END_IF;

(*Counter incremented when State_Pump is true - was off - and Pump_Control is false - is 

now on*)

IF State_Pump_1.value = 1 AND Pump_1_Control.value = 0 THEN

Number_Pump_Starts := Number_Pump_Starts + 1;

END_IF;

IF State_Pump_2.value = 1 AND Pump_2_Control.value = 0 THEN

Number_Pump_Starts := Number_Pump_Starts + 1;

END_IF;

(*Remember current state*)

State_Pump_1.value := Pump_1_Control.value;

State_Pump_2.value := Pump_2_Control.value;

4 The program is now complete
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6.2.5 Trouble-shoot the project 

Now that the project is complete, it is recommended that the project is checked for errors.

1 Open the File menu and select Check Syntax

2 OpenPCS runs a check on all syntax in your program and publishes a log at the bottom of the 

workspace.

– If errors are found eliminate them and check the syntax again

– You can move from error to error with the F4 and Shift F4 keys

3 When the program is free of errors, this is reported in the log at the bottom of the workspace

4 Now open the File menu and select Save All.
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6.3 IEC 61131-3 Simulation

OpenPCS allows the simulation of the IEC 61131-3 program without the need for hardware. It is 

recommended that the program is tested with this function before it is downloaded to the Field 

Controller.

6.3.1 Resources

1 Click on PLC and select Resource Properties from the PLC menu

– The Edit Resource Specifications dialog opens

2 In the Edit Resource Specifications dialog

– Select Hardware Module: ControlCare SIM/Rev 3

– Select Network Connection: EHSIM

– Select Optimization: Size only

– Press OK to confirm the changes and close the dialog

3 Click on PLC and select Rebuild Active Resources (alternatively, press CTRL+F7)

– You can now go "Online" with the simulation.



ControlCare Application Designer: IEC 61131-3 Structured Text Tutorial 6 Program the Hybrid Function Block

Endress+Hauser 57

6.3.2 Go "Online"

1 Click on PLC and select Online from the PLC menu

– If appropriate an OpenPCS Online Server 32 message appears

– Press Yes to download the resource to the server

2 Press the Resource tab and click on the Field Controller in the project window

Note! 

• If there is more than one Field Controller in the project, it appears green and the others red.

• To activate different Field Controller, right click on it and select Set Active, its colour changes to 

green

3 Click on PLC and select Coldstart from the PLC menu

– The Field Controller simulation now runs

– The buttons Power Off, Run and Stop simulate the corresponding operating modes of the 

Field Controller

– The Cycles display show number of cycles simulated and cycle time in ms

– The LEDs simulate the LEDs on the Field Contoller

– To change the macrocycle time, press the >> button and enter a new value in the Cycle 

Time dialog, confirming with OK

4 The simulation is closed by clicking on PLC and select Offline from the PLC menu
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6.3.3 Watch list

By placing selected input and ouput variables in a watch list, the logic can then be checked.

1 Press the Resource tab and expand the FC_01_HY_EMB_IO_1 node

– A list of input and output variables appears

2 Double-click on a parameter to place it in the watch list

– Right-click on the watch list "value field" and enter a value in the Set Variable dialog

– Press OK to confirm the entry and close the dialog

– Parameters can be deleted by selecting the parameter line and pressing DEL

3 Check the logic of each action by seeing the effect of parameter changes on the outputs

4 When you are satisfied that the program does what it should, prepare for download by 

optimizing the preformance
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6.4 Optimize performance

If the IEC 61131-3 simulation was used, the resources must be respecified before the project is 

compiled and downloaded, see Chapter 6. 

OpenPCS allows the hybrid function block to be optimized for speed or size during compilation. 

Default setting is optimized for speed. Optimizing for size causes the block to run slower than if it 

is speed optimized, and is recommended only when there are memory problems, e.g. when a large 

number of hybrid function blocks with long programs are in use or when simulating without Field 

Controller hardware, see Chapter 5.3. 

The settings below are those recommended for normal applications.

Changing the performance 

settings

The settings are made in both the resources and the hybrid function block

1 Click on the Resources tab, then right-click on Controller leaf and select Properties

2 The Edit Resource Specifications dialog appears

– Select Hardware Module: ControlCare SFC162/Rev 4

– Select Network Connection: FC_01

– Select Optimization: Speed only

– Press OK to confirm the changes and close the dialog

3 Now right-click on the Function Block leaf and select Properties

– The Edit Task Specifications dialog appears

– In the Optimization pull-down menu select e.g. "speed only", then press OK

4 Save your settings and close OpenPCS
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7 Go On-line

7.1 Connect to the Field Controller

In order to download the project, the host computer and Field Controllers must be allocated 

IP addresses in the same address range. It is possible to do this on the workbench before installation 

or after the Field Controller and other components have been physically installed in the Fieldbus 

network (subnet). 

Warning

• The use of IP addresses is strictly controlled. Usually your system administrator will be authorised 

to allocate unique addresses. Assigning an unauthorised address to a Field Controller may result 

in conflicts within your system and the failure of the associated devices!

Note!

• The tools that setup the network use Ethernet services that may be blocked by Windows Firewall. 

Normally the firewall will be unblocked for the tools during installation, but it might be necessary 

to stop the firewall should they not function properly. If you are not sure how to stop the firewall, 

consult your system administrator.

Before starting, check the following:

•  Internet Protocol TCP/IP is installed on your computer

•  You have administration rights for your computer

•  You have an set of IP addresses that have been authorized by your IT department

•  Any proxy server for your Internet Browser is disabled

The procedures described in this chapter are for Windows XP. For other Windows systems consult 

your system administrator.

Note!

• When the Field Controllers are physically connected together with the Host computer via 

Ethernet, HSE Network Setup will see the them irrespective of the IP address domain to which 

they belong
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7.1.1 Set the IP address of the host computer

SFC162 Field Controllers are delivered with the default IP address:

•  192.168.164.100 

In order that the host computer can communicate with the Field Controller Web Server, it must be 

allocated an IP address in the same address domain, e.g. 192.168.164.200. If you are not sure how 

to do this, consult your network administrator. 

Procedure 1 Right-click Start =>Settings =>Control Panel =>Network Connections

2 Right-click Local Area Connection => Properties

3 Using the left mouse button, double-click Internet Protocol (TCP/IP) or

click once, then click Properties. 

4 Note the original values of IP address and Subnet Mask of the computer to restore them if 

necessary at end of the operation. 
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5 Change the IP address and the Subnet Mask of the host computer to those required by the 

application. In the example, an address in the same subnet as the Field Controller. 

– IP Address 192.168.164.XXX and network mask (Subnet Mask) 255.255.255.0.

– Do not use the address 192.168.164.100,as these are reserved as default addresses for 

Field Controller SFC162

6 Click on the OK button to complete the procedure, close the other dialogs with OK and 

Close.

7.1.2 Set the Field Controller IP address

Note!

• It is recommended that Field Controllers of the same type are introduced one by one to the 

network.

1 Call HSE Network Setup: 

Programs =>Endress+Hauser=>ControlCare=>Tools=>HSE Network Setup

2 HSE Network Setup is launched and searches for Field Controllers in the Ethernet network.

– All Field Controllers in the network appear, irrespective of their IP domain. 

If this is not the case:

– Check that the proxy server of your Internet Browser is switched off

– Check that the windows firewall is not blocking the program (switch off)

– Check all cables and switches

– If you find two or more Field Controllers with the same IP address, disconnect all but one 

from the network

3 If your computer has more than on NIC card, select the one you want to use for 

communication with the Field Controllers by ticking "Active NIC" and Press .
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4 Right-click on the Field Controller, the address of which is to be changed:

the Field Controller Web Server opens

– The Web Server will only open if the host computer and the Field Controller have 

IP addresses in the same IP domain.

5 Expand the Setup node and click Network

– Enter User Name "pcps" and Password "pcps" to open the Network Configuration dialog

– Enter the required IP address, in our example 10.125.35.180

– Enter a netmask, normally 255.255.255.0

– If required, enter a default gateway, usually address xxx.xxx.xxx.1 in the selected domain

6 Press Update to change the IP address

– You are now asked to restart the Field Controller

– Select the Restart node

– Select "No additional options" from the drop-down menu and press Restart

– Close the Web Browser

– The Field Controller disappears from HSE Network Setup and reappears with the new 

IP address
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7 Now set the address of he host computer to the same domain as the Field Controllers, see 

Chapter 6.1.1 - in our example 10.125.35.200

– Restart HSE Network Setup

– Tick the Field Controller, so that it appears in the HSE Live List associated with the 

computer’s active NIC card.

– Press  to save the configuration.

– You are now ready to download the project

Note!

• If you have more than one Field Controller on the network, Repeat Steps 4 to 6 for all other Field 

Controllers, introducing them one by one to the network.
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7.2 Generate the live lists

7.2.1 HSE live list

Once the Computer and Field Controller are able to communicate with each other, the connection 

to the network can be checked by creating a live list. 

1 Press the On-Line button  in the menu toolbar

– The project goes on on-line

– A red cross appears against the Field Controller in the Project workspace

2 In the Project workspace, right click on HSE Network and select Live List

– A live list is generated of the devices on the HSE network

Note! 

• It may take sometime to generate the live list 

– The devices found first go grey 

– Their profiles (all important device-specific data) including IP address are read

– On successful completion of profile reading, the devices are shown in full black
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7.2.2 Assign the HSE Device IDs

1 In the Project workspace, right click on the Field Controller (CO104) and select Attributes...

2 The Attributes dialog opens

– Open the drop-down menu of the Device ID and select the Field Controller associated

with the displayed TAG (in our case FC_01) - the serial number is on the front panel

– Do this even though the correct ID is already displayed - the program expects it!

– Confirm your choice with OK

– If Application Designer detects a mismatch in version, this is logged at the bottom of the page

(for remedy, see Chapter 7.2)

3 In the HSE Live list, the Controller Icon goes grey, then reappears with the correct tag

4 If several SFC162s were in use, Steps 1 and 4 would be repeated for all.

5 Click on the Project View workspace and Export Tags..., see Chapter 3.10

– Open Project File, then press Save Entire Configuration, to save the project.
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7.2.3 Create the FOUNDATION Fieldbus live list

1 In the Fieldbus network workspace, right-click on Fieldbus 1 and select the option Live List

2 The Fieldbus live list is created

– Check that devices in the project appear in the live list. If not, check connections etc.

7.2.4 Assign the Fieldbus Device IDs

1 In the fieldbus workspace, right click on TT100 and select Attributes...

2 The Attributes dialog opens

– Open the drop-down menu of the Device ID and select the device ID associated

with the displayed TAG (in our case TT100) - the serial number is on the nameplatel

– Confirm your choice with OK

– After a period of time, the red cross disappears from the device in the Fieldbus network

– If Application Designer detects a mismatch in version, this is logged at the bottom of the page

(for remedy, see Chapter 7.2)

3 Repeat the process for the rest of the devices in the Fieldbus network (FT101, FCV102)

– After a period of time, the red cross disappears from the device in the Fieldbus network

4 Click on the Project View workspace and Export Tags..., see Chapter 3.10

– Open Project File, then press Save Entire Configuration, to save the project.
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7.2.5 Assign All Tags

1 In the Fieldbus workspace, right-click on the Fieldbus node at the top of the tree and select 

Assign All Tags

2 The Assign All Tags dialog appears with the list of device and a progress bar

– On completion, the message "Profile reading done" stands next to the Field Controller

and "Tag has been confirmed" next to the devices

– If there are any failures in tag assignment these are logged with reasons at the bottom of the 

screen.

3 As the assignment proceeds, the Field Controller transmits the change to the device

– The device goes grey in the live list

– The Field Controller initiates a new network scan

– After about 1 - 2 minutes, the device goes black and appears with the new tag

4 At the end of the process the live list looks like this

– The "bright" dot next to the SFC162 Field Controller indicates that it is the ACTIVE LAS 

of this segment
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7.3 Download the project

Both the project in ControlCare Application Designer and that in Open PCS must be downloaded 

to the Field Controller. The downloads can be made in any order.

Note! 

• The procedure below describes the initial download for the entire HSE network. 

• Partial downloads can be made later from lower leaves, when changes are confined to this level

• Incremental downloads can be made to a running project by checking the boxes Incremental 

Download and Compare Parameters: Unaffected Local I/Os will hold their last values.

7.3.1 Download the control strategy

1 In the Project workspace right-click on HSE Network 1and select Download

2 The Download dialog appears

– Press Start to start the download

3 The download will be interrupted if the project has not been configured properly, e.g.

– The Controller Tag has not been assigned correctly => Assign Field Controller tags, 

Chapter 6.2.2

– The I/O moduels have not been correctly defined, see Chapter 4.6

4 When the download is successfully completed, the dialog is closed, and you are ready to 

download the hybrid block configuration
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7.3.2 Configure device class

In our project the Field Controller acts as the Link Active Scheduler by default. The FOUNDATION 

fieldbus protocol allows other devices to take over the this role should the Field Controller fail. This 

ensures that any control loop not involving function blocks in the controller will continue to 

function in this event. A device can be setup to be a backup LAS by using the Configure Device Class 

function. This function is only effective when the device is online.

Note!

• If you are offline, the process finishes at Step 2. The change is registered in the project but is not 

downloaded with it. The procedure must then be repeated with the device online, otherwise a 

mismatch when you try to download. 

Procedure 1 In the Fieldbus window, right click on the Fieldbus node to open the context menu

– Select the menu Configure Device Class

2 The Device Class dialog opens

– Select the device(s) you want as backup LAS 

(usually one with few FB links, in our case TT100)

– Press >> to transfer the device to the righthand pane

(if the device does not support LAS functionality, an error message appears)

– Press Apply to confirm the choice and close the dialog.

3 When online, the Change Device Class dialog appears and shows the download progress

4 On completion the TT100 device appears in the live list with a dot indicating backup LAS 

functionality
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7.3.3 Download the OpenPCS project

1 Start OpenPCS by right clicking on FC_01_HY_EMB_IO_1 in the HSE Network 1 tree and 

selecting Program Hybrid Block: 

– If OpenPCS is already running, close it before performing this step

– The attribute settings are exported to OpenPCS

– Click OK to open the OpenPCS workspace

1 Click on PLC and select Online from the PLC menu

– If appropriate an OpenPCS Online Server 32 message appears

– Press Yes to download the resource to the server

2 Press the Resource tab and click on the Field Controller in the project window

3 Click on PLC and select Coldstart from the menu: the hybrid block is started (set to Auto). 

4 If there is more than one controller in the project, each must be cold-started as follows:

– Right click on the controller and select Set Active, its colour changes from red to green

– Click on PLC and select Coldstart from the menu

– All hybrid blocks attached to the controller are forced to Auto

5 Now check the project files

– You will see that the names in watch list are now replaced by values

6 OpenPCS offers a number of options for monitoring values and changing the program without 

stopping execution, e.g. on-line editing –see the on-line help for details.
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7.3.4 Parametrize the Micropilot

The basic parameters for this execrcise are shown in the table below

Procedure 1 In the Fieldbus network workspace, expand the LT101 tree until the function blocks are visible

– Right click on the LT101_TBRL_1 block and select On Line Characterization...

2 The On Line Characterization dialog opens

– The default parameters appear in the value column

3 Expand the Mode Block parameter tree and set Target to OOS

– Set PAROPERATIONCODE = 2457; the calibration parameters become read/write

– Set PARTANKSHAPE to "flat ceiling"

– Set PARDIELECTRICCONSTANT to 1.9 - 4

– Set PARPROCESSCONDITIONS to "calm surface

– Set PAREMPTYCALIBRATION to 3.5

– Set PARFULLCALIBRATION to 3

4 At this point in a real application a map of the empty tank would be made to suppress any 

spurious reflections from objects built into the tank, see BA235F/00/en for details

5 Expand the Mode Block parameter tree and set Target to Auto

6 Press Close to quit the On Line Characterization dialog

– Answer Yes to the request to store the parameters: are settings are then retained for 

any subsequent download to the device

7 Open Project File, then press Save Entire Configuration, to save the project.

Parameter Function Value

PAROPERATIONCODE Sets the parameters parameters to RW in on-line operation 2457

PARTANKSHAPE Configures the application for tank shape, bypass, stilling well flat ceiling

PARDIELECTRICCONSTANT Sets the dielectric constant of the liquid to be measured D.C. 1.9 - 4

PARPROCESSCONDITIONS Configures the device to conditions within tank calm surface

PAREMPTYCALIBRATION Distance from top of Micropilot process connection to desired 

zero level of tank – Parameter E in Fig. 5-1, Chapter 5.3

e.g. 3.5

PARFULLCALIBRATION Distance from selected zero level to desired 100% level of tank 

– Parameter F in Fig. 5-1 Chapter 5.3

e.g. 3.0
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7.4 Check the control stategy

7.4.1 Control strategy

1 Click in the Control Strategy workspace (Pump control) and press the button  in the menu 

toolbar – the control strategy also goes "on-line"

– Values appear in green when the status is good

– Values appear in red if the status is bad - at this stage this is an indication of a communication, 

block configuration, strategy configuration or device parametrization error

2 If you have the possibility of changing the signals, change each input in turn and check the 

effect on your strategy.
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7.4.2 Optimization of hybrid block execution time

1 Open the HSE Network 1 dialog, then click on the "details" icon in the menu bar

– The execution times are shown next to each block

– The FC_01_HY_EMB_IO_1 block executes at the default time of 30 ms

2 Right-click on the FC_01_HY_EMB_IO_1 block and select On Line Characterization

– The parameter EXEC_TIME_ACTUAL shows the time in which the block is executing

– Observe the value for a couple of minutes and note the highest value

3 Now change the function block execution time to the new value

– Right-click on FC_01_HY_EMB_IO_1 and select On Line Characterization

– Double-click on the "value space" next to the parameter EXEC_TIME_TARGET

– Enter a value 10% to 20% higher than the highest observed actual execution time

– Press End Edit to store the value and Close to quit the dialog.

4 Right-click on the Bridge node (FC_01) and select FB Schedule Download 

– The new value is downloaded to the Field Controller

– The strategy now runs with the new target execution time

5 Repeat Steps 1 to 4 for all hybrid blocks in the strategy

Note!

• EXEC_TIME_ACTUAL will be too high if the ST program is being monitored on-line by 

OpenPCS. Close the application before checking the value.
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7.5 Modify the project

7.5.1 On-line characterization

Once the project is on-line you may want to change parameters to e.g. tune the control-loop or 

eliminate configuration errors. With the exception of the SP parameter, the function block must be 

put out of service before the parameter is changed:

1 In the Control strategy workspace double-click on the function block you want to modify, or in 

the HSE network 1 or Control module workspace, right-click on the function block and select 

On-line Characterization

2 The function block On-line Characterization dialog appears:

– Open the Mode leaf and double-click in the space next to Target

– Set the Target to OOS (Out of Service)

– Click End Edit to set the parameter

3 Change the parameters you wish to modify

– If appropriate, open the parameter leaf and double-click in the space next to the parameter 

you require

– Enter the new parameter or select it from the drop-down menu

– Click End Edit to set the parameter

– Repeat the procedure for all the parameters you wish to modify

4 Put the function block back into standard operating mode

– Open the Mode leaf and double-click in the space next to Target

– Set the Target back to the original value (Auto (Automatic) or Cas (Cascade))

– Click End Edit to set the parameter

– Check that the Mode really changes to the Target Mode (failure to do so indicates a 

configuration error)

– Press Close to store the values (if you are prompted - answer with Yes)

5 Click on the Project View workspace and Export Tags..., see Chapter 3.10

– Open Project File, then press Save Entire Configuration to save the project

6 Put the Control stategy back "on-line" to check the results of your modification, Chapter 6.4.
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7.5.2 Off-line characterization

You may prefer to change parameters off-line, e.g. when modifying the control strategy or adding 

new functions to the project. 

1 If you are on-line, press the Off-line button  in the menu toolbar

alternatively, in the PROFIBUS network or Control module workspace, right-click on the 

function block and select Off-line Characterization

– The function block Off-line Characterization dialog appears

2 Change the parameters you wish to modify

– If appropriate, open the parameter leaf and double-click in the space next to the parameter 

you require

– Enter the new parameter or select it from the drop-down menu

– Click End Edit to set the parameter

– Repeat the procedure for all the parameters you wish to modify

– Press Close to store the values

3 Click on the Project View workspace and Export Tags..., see Chapter 3.10

– Open Project File, then press Save Entire Configuration to save the project

4 Press the On-line button  in the menu toolbar to go on-line again

5 Download the modified project

– In the Project workspace right-click on HSE Network 1and select Download

– Follow the procedure in Chapter 6.3

6 Put the Control stategy back "on-line" to check the results of your modification, Chapter 6.4.
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7.6 Packing and unpacking the project

In order to install the project at the customer’s site, the project can be packed and unpacked. It is 

important to remember, especially if you have not been using the actual project devices to test your 

project, that the instruments on site may be have newer (or even older) DD/GSD/CFF files than 

the ones you use. The latest DD/GSD/CFF files must then be uploaded to the project and 

corresponding corrections must be made to configuration, before it is downloaded to the Field 

Controller. The is done with the Import Device Support... item in the Project File menu, see 

Operating Instructions BA017S/04/en, Chapter 3.1.5.

7.6.1 Pack the project

1 Select Project File => Pack Project...

– The Pack Project dialog appears

– Browse to the folder where the files will be created

You can create a folder with the Make New Folder button 

– Enter the name of the project

– Press Save to save the packed project

– Press OK to close the successful packing message dialog

7.6.2 Unpack the project

1 Select Project File => Unpack Project...

– In the Unpack Project dialog

– Browse to the folder where the packed project is located

– Click on the name of the project

– Press Open to save the packed project

2 In the Browse for Folder dialog:

– Browse to the folder where the project is to be installed

You can create a folder with the Make New Folder button 

– Press OK to start upacking

– Press OK to acknowledge the successful unpacking of the project

7.6.3 Unpack the OPC data base only

For some applications it may be necessary to update the OPC data base of a SCADA program that 

has no provision for importing new DDs etc.. This can be done in Application Designer, which 

allows the separate unpacking of the OPC data base.

1 Go online, then right-click on the HSE OPC Server icon in the system tray

2 Select Unpack Configuration...:

– Unpack the OPC data base to the folder required according to the Steps 1 and 2 in

Chapter 7.6.2 above.
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7.7 Export the configuration

For documentation purposes, the project configuration can be exported to an existing ODBC file 

data source, e.g. Oracle, a machine database, e.g. Excel to provide a record of the current status of 

the project or to an XML sheet for viewing with a browser.

7.7.1 File data source folder

The file data source must have been created before the export.

1 In the Project window, right-click on the Project icon and select Export Configuration:

2 The Select Data Source dialog box appears

3 In the File Data Source folder, select the source that describes the driver that you wish to 

connect to. You can use any file data source that refers to an ODBC driver which is installed on 

your machine.

– Use the New... button and Look In dropdown menu to browse or 

– Click the data source icon to select the driver:

– Press OK to make the connection
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7.7.2 Machine data source folder

The Machine Data Source is specific to the machine, and cannot be shared. "User" data sources 

are specific to a user on the machine; "System" data sources can be used by all users on the machine, 

or by a system-wide service. The Machine Data Source must have been created before export.

Procedure 1 In the Project window, right-click on the Project icon and select Export Configuration:

2 The Select Data Source dialog box appears

– Click on the Machine Data Source tab to open the folder

– Double-click the data source name to select the machine, e.g. Excel:

3 The Select Workbook dialog box will appear:

– Select the folder where the data file is and double-click the workbook icon.

– Your project configuration will be exported to the workbook file.

– A message box appears on completion - press OK

4 Open the Excel file to check the result:
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7.7.3 XML file

1 Click in the Project workspace and select Project File =>Export => Configuration as XML

– The Export Configuration as XML dialog appears

2 Enter a File Name and Save In location, then press Save

– The project is saved as an XML file at the selected location
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7.8 Close Application Designer and OpenPCS

When you have completed your session, close Application Designer and OpenPCS

7.8.1 Application Designer

1 If you are on-line, press the Off-line button  in the menu toolbar

2 If you have made any modifications while you were on line, you will be prompted to store 

them

– If appropriate answer with Yes

3 Close the project by clicking on Project File => Close

4 Exit Application Designer by clicking on Project File => Exit

5 The Field Controller continues to operate with the project configured according to the last 

download/on-line correction

– If you switch off the Controller, the project remains stored in its memory

(provided the battery DIP switch is on, see BA021S/04/en: Field Controller, Hardware 

Installation)

– It is initialized and re-executed as soon as the Controller is switched on again

7.8.2 OpenPCS

1 Open the PLC menu and select Offline

2 Open the File menu and select Exit

– You will be prompted to save if your project has been changed since the last download

7.8.3 Reconnecting Application Designer

Provided your computer is operating in the same IP address domain as the Field Controller, you can 

reconnect at any time.

1 Start up Application Designer and select the Project you require

2 Press the On-line button  in the menu toolbar

3 Expand the various workplaces as required

4 Click in the Control Strategy workspace and press the button  in the menu toolbar – the 

control strategy goes "on-line" with the last configuration that was downloaded.

7.8.4 Reconnecting OpenPCS

Provided your computer is operating in the same IP address domain as the Field Controller, you can 

reconnect at any time.

1 Start up OpenPCS, open the File menu and select the project you require

– Open the File menu and run Check Syntax

2 Open the PLC menu and select Online
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8 Trouble-Shooting

8.1 Factory initialisation and reset

Warning!

• Do not use the pushbuttons located in the Field Controller unless you are certain that you want 

to reset the system.

Two pushbuttons located on the SFC173 module, see Fig 8.1, allow the system to be initialised and 

reset. The function and effect of the buttons is described in the table below.

•  To "click " the pushbuttons use a pointed instrument (e.g. a ballpoint pen). 

Other functions of the two buttons are to be found Chapter 7 of the Operating Instructions 

BA035S/04/en, Field Controller: Commissioning and Configuration..

Function Effect Procedure

Reset Resets system: the last 

configured IP Address 

is used

• Click the right pushbutton - the system resets (takes several seconds)

• If no IP Address is found, a new one is assigned automatically

• Verify that the RUN and ETH LNK LEDs are lit.

Factory Init Deletes application, 

the last configured IP 

Address is retained

• Keeping the left pushbutton pressed, click the right pushbutton

• Check that the FORCE LED flashes once a second. 

• Release the left push button. The system resets, see above.
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8.2 Trouble-shooting tables

8.2.1 Field Controller

Problem Remedy

1 HSE Network Setup/FC Tools does not find any 

Field Controller

• Disable the Windows firewall (normally a message 

appears ask whether you should unbock the program)

• Disable the proxy server for your Internet browser

• Check that you are using the correct Ethernet cables, 

see ETH LINK below

• Check that all etehrnet switches are powered up

• Check that the network adapter is on and OK: Execute a 

PING command to its own IP, via DOS PROMPT.

• Check if the Ethernet connection is OK: Execute a PING 

command to the Field Controller.

2 Field Controller appears intermittently in FC Tools Host and Field Controller are in different subnets.

• Normal behaviour, but for firmware download both host 

and Field Controller must be in the same subnet

3 HSE Network Setup/FC Tools does not show all the 

Field Controllers that are in the network

There is probably an IP address conflict in the network.

• Disconnect all the Field Controllers except one from the 

from the sub-network

• If necessary, change its IP address

• Now reconnect the other Field Controllers one after the 

other, if necessary changing their IP addresses

4 Field Controller Web Server does not open No Ethernet connection

• Disable the Windows firewall

• Disable the proxy server for your Internet browse

• Wrong subnet IP address

Host and Field Controller must be in same subnet

• Wrong subnet mask

Host and Field Controller must have same subnet mask

5 Firmware begins to execute but after a certain time it 

stops

It might be a configuration problem. 

• Use the Factory Init procedure and configure the Field 

Controller again. 

• If the problem persists, see the relevant chapter in 

Operating Instructions BA035S/04/en, Field Controller, 

Commissioning and Configuration

6 HOLD LED remains lit If the HOLD LED remains lit after the Field Controller has 

been turned on, the firmware may be invalid. 

• Update the firmware, see the relevant chapter in 

Operating Instructions BA035S/04/en, Field Controller, 

Commissioning and Configuration

7 ETH LNK LED does not light Check if the cable is connected correctly, or that the cable is 

not damaged. Check the specification of the cables:

• SFC954 - Cable Standard.  To be used in a network 

between the Field Controller and a Switch/Hub.

(preferred configuration)

• SFC955 - Crossed Cable (Cross).  To be used point to 

point between a PC and the Field Controller

(some PCs/laptops may have problems with crossed 

cable)

8 FRC LED is flashing (Force) Field Controller is powered up for the first time

• Battery is not switched on (see BA021S/04/en, p50)

Field Controller is in reset mode

• Complete the RESET procedure

Field Controller is in normal operation

• Battery is flat: 

– No problem if controller remains powered up

– If power is switched off, the project will be lost and 

must be downloaded again from Application Designer 

on repowering
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8.2.2 Application Designer

Problem Remedy

1 Field Controller does not appear in HSE live list No connection to Field Controller

• See Remedies for Items 1, 2 and 4, Chapter 7.3.1

• Field Controller is on HOLD, set it to RUN mode

• IP address is not configured correctly, use PING to check

2 Field Controller appears but always stays grey in HSE 

Live List

No connection to Field Controller

• Check that host and Field Controller are in same subnet

3 Red cross appears on the Field Controller No communication with Field Controller

• No Ethernet connection with Field Controller, 

check connection, IP address etc, see above

• No Device ID set in the Field Controller (Attributes)

4 Red cross appears on Fieldbus/Profibus No communication with fieldbus/Profibus

• No communicaton with Field Controller, see above

• Fieldbus/Profibus not connected to controller

5 Red cross appears on field device No communication with fieldbus device

• No communicaton with Field Controller, see above

• No communicaton with fieldbus, see above

• No Device ID set (Attributes)

• Tag not assigned (Assign Tag)

6 A device does not appear in the live list Communication error

• The device is not powered up

• The project has been updated but no download has been 

made yet

7 Configuration will not download You have either a communication problem or the 

configuration is not complete

• Check that you are on-line - press the On-line button

• Check that your computer is in the same address subnet

• Check that you have assigned the Field Controller tag

• Check that you have exported all tags OPC server

• Check that the parameters are in the recommended order

• Check that the OPC server is running (look for icon in 

bottom line)

• Try "Update" from the Field Controller node and 

download again

9 Parameter appears red in the on-line control strategy The parameter has a bad status

• Check that the Block Mode is Auto (or Cas)

• Check that the block has been correctly configured

• Check that the device is still live (live list)

• Check that the device address is the same as that you 

have in your configuration (live list)

• Check that the parameter has been correctly configured

• Check that the tags were exported (Export Tags)

10 FB links do not work Project not downloaded correctly, e.g. partial download 

when bridge has HSE links

• Repeat full download from the HSE Network node
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